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Chapter 1 - Account Overview 
Account Management Areas 

 
Chapter 2 - Getting Started 

The Files In Your Account 

When you initially log into the root of your account, dependant upon the method which you choose to log in, 
you will see various hidden files and directories, among them, the two that hold the most importance are the 
public_html and public_ftp directories. 

public_ftp 
public_html 
 
DO NOT DELETE OR RENAME any of these directories or any hidden files that you may find. These 
directories are automatically setup by the system and required in order for your account to function. Deleting 
or renaming any of them will cause fatal errors that can only be repaired by deleting and resetting your 
account. Deleting and resetting your account will inadvertently cause you to experience DNS problems. DNS 
problems are not something that can be manually fixed, as they can only work themselves out in an 
unpredictable amount of time. 

Of these directories, the ONLY ONE that is important to you is the public_html directory. This is the 
directory where you will upload your web pages and create other subdirectories that will pertain to your web 
site and be viewable from your web browser. Your pages WILL NOT be viewable on a web browser unless 
they are uploaded to this directory. 

When you initially enter your public_html directory, you will see only one directory, which is your cgi-bin. 
The cgi-bin is where you upload your cgi scripts. DO NOT DELETE OR RENAME your cgi-bin. 

As you add features from your Control Panel, the system will automatically create other directories within 
this area. ANY AND ALL sub-directories and/or files created by the system are required by the system to 
make a particular function operate and SHOULD NOT BE DELETED OR ALTERED IN ANY WAY. The 
index.html page is the default entry page for your account and this file SHOULD BE REPLACED by one of 
your own design, but IT MUST BE named index.html. 

Where and how to upload your files 

ALL files must be uploaded to your public_html directory. 

Files are uploaded to your account via WS_FTP, CuteFTP, or Fetch or any other FTP program that you may 
prefer. Please refer to Chapter 1 for instructions for setting up your FTP client. For more in depth 
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information pertaining to your FTP Client, refer to its documentation. 

There are also numerous tutorials for using FTP out on the web, simply do a search for FTP tutorials. We 
located one at http://www.computrnet.com/tutorial/ftp.htm. 

How to view your pages on the WWW 

If your domain name is not yet live on our servers, you can view your pages by using your IP address as 
follows: http://your-ip-address/ .Be sure to include the forward slash after your ip address. If your domain is 
live on our servers, you can view your pages within any browser by typing any of the following in your 
browser: (of course replace yourdomain.com with your actual domain name and its extension.) 
 
http://www.yourdomain.com 
http://yourdomain.com 
www.yourdomain.com 
http://www.yourdomain.com/index.html 
http://yourdomain.com/index.html 
www.yourdomain.com/index.html 
 
If you are getting an error when typing the above, several things could have gone wrong, these are as 
follows: 
 
1) Your initial page is not named index.htm 
l 
2) The code in your index.html page is incorrect 
 
3) The registration/transfer request for your domain has not been completed. (this process can take up to 72 
hours. If it has been 72 hours and the transfer of your domain has been requested through Network Solutions, 
Resellers will need to contact Network Solutions themselves using the “tracking number” provided in their 
confirmation email. Our regular hosting clients need to submit our Technical Support Request Form and 
provide us with the Tracking Number so that we can contact them. 
 
4) Your account has been deactivated due to non-payment,/non-compliance of our policies, or spamming 
violations - users need to contact Technical Support. 
 
The best advice that we can pass on to our users is DO NOT SPAM. There are only so many backbones and 
while you may find it convenient to hop around from hosting company to hosting company, eventually you 
will start getting "We don't want your business" replies from the hosting companies. This is because the 
backbone will not allow them to host you because you've been banned for spamming. You don't have to like 
this rule, but it's the one that rules your existence on the Internet. 
 
Are you unsure of what spamming is? We can make this short and simple for you. Spamming is the sending 
of any unsolicited email to an email address who’s owner did not invite you to send an email to them. 
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Chapter 3 - Control Panel Overview 
 
Our Control Panel makes setting up your web site easy! The Control Panel itself is a user-
friendly graphical interface that permits quick and easy access to all the features available to 
your particular account plan. The features inside the Control Panel automate processes that 
users must do manually with other hosting services. 
 
NOTE TO FRONTPAGE USERS: Most of the options in your Control Panel 
will NOT work with FrontPage Extensions installed. It's a known fact 
throughout the industry that Microsoft has established itself as a "world in 
itself" and therefore the majority of their software is incompatible with the 
other world. We provide FP Extensions as a courtesy to those that know how 
to use it and prefer it over the more common methods of designing web sites. 
If you choose to utilize FrontPage, we have provided some brief information 
that will assist you in Chapter 7 of our manual. 
 
File Manager By clicking this option you can view all the directories and files 
in your account, as well as change permissions for directories and files, create 
directories, create and edit files, and upload files from your hard drive to your 
account. 
 
Mail Manager This option is where you create and edit, change passwords, 
forward email to other email accounts, and create autoresponders for your 
Pop3 email accounts. (Quick Note: It is not necessary to create email aliases 
as your default email account acts as a "Catch All Account.” In other words 
anything@yourdomain.com will be delivered to your default mail account.) 
 
Change Password Click this option to change the password for your Control 
Panel and FTP Client. 
 
Site Statistics This option will assist you in monitoring visitors to and from 
your site. This area features 3 different views of your traffic: Analog, which 
basically provides you with a quick summary, Webalizer, which provides you 
with more detailed information, and Last 300 visitors, with detailed 
information on each. This area also contains a link to access your error log, 
which will assist you in trouble shooting your scripts. 
 
Network Tools This option provides you with dns lookup capabilities and 
traceroute. 
 
FTP This option is available in accounts with multiple ftp accounts and also 
those with anonymous ftp. From here your can set your users up, setup how 
anonymous users are treated, change anonymous policies, view who is online, 
and boot anyone from a session. 
 
SSH / Telnet We are in the process of having RSA established and once that is 
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completed, users will be able to access this feature just as any other telnet 
client and issue commands. 
 
Password Protect Directories You cannot use this option with FrontPage. This 
option will have to be done in FrontPage. 
 
Password protecting your directories has never been easier. This option allows 
you to select the directory you wish to password protect from a drop down 
box and then enter usernames and passwords of those you want to allow 
access to that part of your web site and remove them just as easily...all at the 
click of a button. 
 
Custom Error Pages This option will assist you in customizing how your error 
pages look. It includes: 400, 401, 403, 404, and 500 error pages. 
 
MySQL MySQL is a database engine that you can use with your web site. 
There are two separate features in the Control Panel. One allows you to create 
your databases and assign users while the other feature permits you to edit the 
database. 
 
Mime Types MIME = Multipurpose Internet Mail Extensions - This option 
allows you to add Mime Types to your account. Refer to Chapter 20 for more 
information regarding this feature. 
 
You cannot use this option with FrontPage Extensions installed. You will 
have to use FrontPage to perform this function. 
 
Crontab This option will assist you setting up automated processes. 
 
Entropy Chat This option will allow you to setup a web based chat on your 
site. 
 
Shopping Cart This feature is not yet completed. However, once it is 
complete, users will be able to setup a fully functional shopping cart on their 
site at the click of a button. 
 
Search Engine Submission This option will assist you in submitting your URL 
to several of the popular search engines in one click. We are testing this area 
with several different scripts, so it's going through changes. 
 
PGP = Pretty Good PrivacyTM This option allows you to install a public key 
for your PGPMail. 
 
Sub Domains This option will assist you setting up subdomains inside your 
account plan. Subdomains are anydomain.yourdomain.com. The subdomains 
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that are setup through your control panel draw their resources from the parent 
plan and do not come with an IP address. 
 
Archive Manager This feature allows you to compress and backup your 
directories and files. 
 
CGI Scripts This option provides you with easy installation of the following 
cgi scripts: 
 
Random HTML Editor 
 
Guest book 
Counter 
Clock 
Countdown 
Formmail 
Entropy Search Engine 
 
Chapter 1 - FTP Software Instructions 

 

Introduction To FTP 
 

All of your files and subdirectories go into your public  html directory. 

Now that we've distinguished where your files go, there are several ways 
depending on your computer system, that you can transfer files to your 
account directory. The process by which files are transferred to the web server 
is called "FTP" (File Transfer Protocol). You have unlimited access via FTP 
24 hours a day. As such, you can create and maintain your web pages on your 
own computer and upload files to your web site at your leisure. 

To upload your files to your account, you need an FTP program. 

For the PC users, visit http://www.wsftp.com/ to download the newest version 
of WS_FTP LE for the PC, one of the most popular FTP programs on the 
web. 
 
For the Macintosh, a program called "Fetch" is used. Visit:  

http://www.dartmouth.edu/pages/softdev/fetch.html to download the newest 
version of Fetch. 

Back to the top 
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WS_FTP LE For PC Users 
 

Each time you run WS_FTP, the 
Session Profile window will be 
displayed. Initially the window will 
be blank as seen in Figure A and after 
you've created your first profile you 
will need to click on the "NEW" 
button in order to get a blank profile 
or click on the drop down box to 
select an existing profile to use. A 
profile contains the information 
needed to connect to your web site 

 

 
 
To create a profile, you will need to fill in each area with the information as 
follows: 
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Profile Name: This should be 
a name that will enable you to 
recognize it from other profiles. 
In figure B we're giving it the 
name "Your Domain." 

Host Name/Address: This 
should be either your IP 
Address (if your domain is not 
live on our server yet) or your 
domain name (if it is live on 
our server) Ex: 216.74.88.XXX 
(without the http://www in 
front of it). Your IP address was included in your welcome letter. 

Host Type: This should be set at Auto Detect 

User ID: This is your username as provided in your welcome letter. Linux is 
case sensitive so be sure to type your username exactly as it appears in your 
welcome letter. 

Password: This is your password as provided in your welcome letter. Linux is 
case sensitive so be sure to type your username exactly as it appears in your 
welcome letter. To the right of the password there is a box to have WS_FTP to 
automatically remember your password so that you do not have to enter it 
each time you start this session. Check it to make your life less complicated. 

Many of our users need to disable Passive Transfer in order to connect. This 
can be done by clicking on Options, then selecting the Session tab and 
removing the check from "Use Passive Transfer Mode" 

Once you have completed the above steps, you are ready to save your changes 
and then connect to your account. Simply click on Apply in the lower part of 

the window, and then click on OK. 

Once connected, your window will look like 
the figure to the right. You will see two 
separate windows. The window on the left  
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 is your actual hard drive and the one on the right is your domain account. 
You can navigate your hard drive to locate where your files are by double 
clicking on the green arrow, move up to a different directory and by double 
clicking on a folder to go inside that specific directory. 

The window on the right is your domain account and when you first log in 
you will be in the root of your account. You need to double click on the 
public_html folder to open the directory where you upload all of your files 
and create subdirectories for pages that you want to be viewable through your 
browser. 

When you 
initially log into 
your 
public_html 
directory you 
will not see any 
files, but you 
will see one  
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directory, which is a system directory named cgi-bin. Do not rename or delete 
this directory. This is the directory where you upload any 3rd party cgi scripts 
and is also the directory where the system stores scripts installed through your 
control panel. 

To upload your files to your public_html, simply navigate through your hard 
drive to locate your files in the left window. You can upload one file at a time 
by selecting one file, a group of files by holding down your control key while 
selecting the files you want moved over, or an entire directory by clicking on 
the directory, and then clicking on the arrow pointing toward your domain. 
Your initial page for your web site must be named index.html or index.htm 
otherwise visitors will not reach your domain when typing in 
www.yourdomain.com. 

As soon as a file is uploaded to the web server, it is available for all to see. If, 
after uploading a file, you are still unable to see the updated file via Netscape, 
try hitting the "Refresh" or "Reload" button. If that fails, you need to clear 
both disk and browser cache. This function can be found by selecting 
Options>Network Preferences in Netscape. Remember that you must first be 
connected to the Internet through your local Internet service provider in order 
to connect to the web server. 

 Back to the top 

 

Fetch For MAC Users 
 

The following information is contained within your account activation notice and is needed to 
connect to your web site via FTP: 



  11

USERID 
PASSWORD 
FTP HOSTNAME 

The hostname tells your FTP software to connect to the web server upon which your web site 
resides.  

Each time you run Fetch, the New Connection window will be displayed. A profile contains 
the information needed to connect to your web site. Creating a profile now will eliminate the 
need for you to configure the software each time you wish to connect to the web server via 
FTP. To create a new profile, select "New Connection..." from the File menu. Next, enter the 
Host (yourdomain.com), User ID (yourdomain), and password for your web site as illustrated 
below.  

 
 
Don't worry about the Directory option right now. When you have your Host, 
User ID, and Password entered, click on the OK button.  
 
The next window, which will pop up, will look virtually the same as below, 
except that yourdomain will be in the pop-up window.  
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Bookmarking the Connection 

You should take the time, now that you have established your connection, to make it easier 
for you to get here next time. Under the Customize menu, select New Shortcut. A window 
will pop up called Bookmark Editor, as shown below. It will already have your name, Host, 
and User ID filled in. Under Type, choose File from the pop-up menu. If you would like Fetch 
to remember your password so you won't have to type it in each time, type in your password 
in the Password field. Now, under the same Customize menu, choose Preferences, and under 
the General tab, make sure the connection you just entered is selected as the default shortcut. 
Next time you open up Fetch, your shortcut will be opened automatically and all you'll have 
to do is click the OK button!  

 
 
How to Transfer Files 
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Refer again to the sample window above. You need to double-click on www to get to your 
web directory. This is where all your files will be downloaded, and/or you will create sub-
directories. The only system directory that you may need to use is cgi-bin. This directory is 
reserved for custom scripts. To make your home page load automatically, name the HTML 
document "index.htm" in lowercase and upload it to the www directory of your account. To 
upload a file or files, simply drag them from your hard drive onto the Fetch window when you 
are in the appropriate directory or subdirectory. Be sure to upload HTML documents and 
scripts in Text mode and images in BINARY mode. Or to make life easier, click on the 
Automatic button as shown in the sample window above, and Fetch will decide the proper 
format. To transfer a file to a subdirectory, double-click the appropriate subdirectory to open 
it before transferring the desired file(s) 

To insure that the Automatic selection works properly, make sure the 
selections under the Upload tab in the Preferences window looks the same as 
below.  

 
 
 
As soon as a file is uploaded to the web server, it is available for all to see. If, after uploading 
a file, you are still unable to see the updated file via Netscape, you need to hit the Reload 
button in the Netscape button bar. Remember that you must first be connected to the Internet 
through your local Internet Service Provider in order to connect to the web server. 
  
Back to the top 
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Chapter 2 - Telnet / SSH 
 

Gaining Telnet Access 
 

Telnet Access will be available using SSH in the very near future. 

Any user gaining Telnet Access assures us that they are an experienced Telnet 
user. In the event that such user causes any server crashes/damages, their 
Telnet Access privileges will be revoked and denied for any future Telnet use. 

For now, you can telnet to your account using your username and 
password. Once SSH has been enabled, users will have to setup their 
SSH/Telnet software accordingly. Below are the instructions for SecureCRT 
once SSH is enabled. 

If you need telnet access to our servers, it can only be done using SSH. We 
have it set up to use RSA authentication. You will need to create a key using 
your PC's SSH software, then use the SSH feature within your Control 
Panel to upload the key to our servers. Once it is uploaded, you will be able 
to connect to our servers using SSH.  As a suggestion , you can visit 
http://www.vandyke.com and download their SecureCRT software. This 
software is available as a 30-day trial and afterwards must be purchased. 
Below we have provided instructions on setting up the software. 

 

Setting Up SecureCRT Software 
 

Each time you run SecureCRT, the following box will appear on your screen. 

 
Ensure that the Session List tab is selected and then click on the New button 
on the right hand side. This will create the session that you will use each time 
you telnet into your account. 
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Following is a shot of the next screen you will see. (Instructions for this area 
follow this screen shot.) 

 

 
NAME - In the text box next to Name, input a name that SecureCRT can use 
to identify this session that you are creating. 
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PROTOCOL - Select SSH from the drop down box. 
 
As soon as you select SSH, additional boxes will appear below that selection 
as follows. 

 
 
Connect via firewall - Leave this box unchecked. 
 
HOST NAME OR IP - Enter your domain name or IP number in this text box. 
(i.e.. yourdomain.com) 
 
PORT - Leave the default number that is there. 
 
USERNAME - This is the username that you use to FTP to your account. 
 
CIPHER - Select 3DES 
 
AUTHENTICATION - Select Password from the drop down box. 
 
PASSWORD - This is the password for your account, the same one you use to 
FTP to your account. 
 
Next you will need to click the Advanced button as indicated in the screen 
shot below. Be sure to hit the Advance button and not the Advance tab. 
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In the next screen (Advanced SSH) the Use Global radio button is selected by 
default, and the text box directly beneath that will automatically be filled in 
with a file location. 
 
Next locate and click on the Create Identity File button as indicated in the 
screen shot below. (Everything else on that screen should remain as is.) 



  18

 
 
The next step will generate the key that will identify to your sessions. This 
key will be uploaded the first time that you Telnet to your account. Click on 
Next as indicated in the screen shot. 

 
 
In the next screen you are asked to insert a Passphrase. By providing this 
passphrase your key will be encrypted. Next you are asked to confirm that 
passphrase, just as you are when you provide a password. Once you've 
provided this information, click on Next as indicated in the screen shot below. 
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In the next screen you are asked for a length for your RSA pair, just accept the 
default and click Next as indicated in the screen shot below. 

 
 
In the next screen your key is actually generated. Move your mouse around 
until the status bars are complete and then click on Next as indicated in the 
screen shot below. 
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In the next screen you are prompted for a location in which to save your Key 
and Key Pair. You can accept the default, however if you want this 
information saved in a different location, be sure to write down the location as 
it will be needed when you Telnet to your account the first time. Also, you 
should save both files in the same location. Click on the Finish button as 
indicated below when you have selected the location. 

 
 
You are now returned to the Advanced SSH window. Just click on the OK 
button at the bottom of that window to close that screen, at which point you 
are returned to the Session Preferences Window. Again, click on the OK 
button at the bottom of that window to close that screen. 
 
Install the key in the SSH section of your control panel. In the space provided, 
copy and paste your public (RSA) key from your software (this insures the 
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key is exactly as it appears in your software). Note: You will also be asked to 
enter your access addresses, which are the IPs or host names from which you 
will be accessing the server. If you do not know your access address(es), 
contact your ISP for the information. If your address(es) is/are not static, 
follow the examples below: 
 
Example 1: ISP tells you that your IP ranges from 209.239.4.1 through 
209.239.4.30 (this means that each time you log on, your IP address could be 
any number between these). You should enter the address as 209.239.4.* (the 
* is a "wild card" and can take the place of any digits.) 
 
Example 2: ISP tells you that your host name will either be 
home.name.you.aol.com or home.name.me.aol.com. You should enter the 
address as *.aol.com (In this case, the * replaces anything that may come 
before .aol.com). 
 
Once addresses are listed, submit the request. This generally takes about 10 
minutes, then you will be able to test it. You are now ready to Telnet to your 
account by clicking on File and then on Connect or you can click on the 
Connect icon (3rd icon from the left). When you have successfully connected 
to your account, you will be prompted to save the key that you just generated. 
Follow the instructions on your screen and once you've done this you are 
ready to work within your account. From here it's just like a normal Telnet 
session. 
.
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Chapter 3 - Email Software Setup 
 
 Spamming is STRICTLY prohibited. By running closed servers it is a lesser 
chance of the servers getting knock down from spamming. Also, since you 
must have a dial up to access the server anyway, you can utilize this account 
for your outgoing mail. By doing this, the servers run better and faster without 
the SMTP servers open. 90% of the hosts out there use this system, the ones 
who do not, charge you for it. 

NOTE: You must use YOUR dialup SMTP information, where you are asked 
for your outgoing SMTP account. You should obtain this information from 
your dialup Internet Service Provider. 

It is a simple process to set up your accounts to send emails. We've included 
instructions for the four most popular email clients below. 

 

Eudora Lite Email Settings: 
 

This is a mail program that runs under MS Windows and Macintosh OS. Eudora connects to 
the mail server over the Winsock or Macintosh TCP/IP. Mail may be composed and read off 
line, but make sure that Winsock or TCP/IP is running before attempting to send or receive 
email. Although your account exists on our server, you won't be able to receive email at 
yourname@yourdomain.com until your domain name becomes live on the WWW. 

After Eudora has been installed, it must be configured to point to your server. 
To do this, start Eudora and select "Settings" from the menu bar. Most of the 
options are self-explanatory. Here are the steps you need to perform to set up 
Eudora:  

1) Install and start up the Eudora program 

2) Select "Settings" from the "Special" menu 

3) Select the "Getting Started" tab, then under Real Name, enter your Real 
Name.? 

4) Under "POP Account," enter your dialup email address. 

5) Leave Return Address blank unless you want people to send return email to 
you at a different email account. You can use one of your domain addresses in 
this area if you wish. 

6) If you use the Macintosh version, the radio button for TCP/IP connection 
should be highlighted. 

7) Click the "Personal Information" tab (also only for the Macintosh version). 
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8) Under POP account, put your dialup email address, again. 

9) Fill out the "Real Name" and "Return Address" as you did before 

10) Under "Dial up User Name," enter your username. This is the username 
you use with your dialup account. 

11) Click the "Hosts" tab, then enter your Internet dialup account information. 
This generally looks something like mail.earthlink.net. (check with your 
Internet Service Provider for the correct Outgoing SMTP information). 

12) Go to the "Checking Mail" tab and make sure "Save Password" is 
checked.  
 
That's pretty much all the configuration Eudora needs. Many of the 
configuration areas will be filled in when you go to them. For instance, it will 
usually fill in the POP account info wherever it needs it after you enter it the 
first time. Now, when you select "Check Mail" under the File menu, a window 
will pop up asking for your password. Enter in your password then click on 
the proceed button and Eudora will check to see if you have email. You can 
now send a test email message to yourself and then check to see if it gets 
returned to you. If you checked "Save Password" as in step 12, Eudora will 
not prompt you again for your password after the first time. If multiple users 
have access to your computer, and you don't want them to have access to your 
email account, make sure "Save Password" is unchecked 

Once you have completed the above steps, you can now send email from your email client. 
The next step would be to create multiple accounts using your email accounts that you have 
created with your domain. When setting up additional accounts, you must always use your 
dialup account for your outgoing email and using the return email address for your domain 
mail account. Your domain account would be your incoming SMTP and this would look 
something like this: (depending on what email accounts you have created) 

anything@yourdomain.com and then you would enter your username and password that you 
have setup for that particular email address. 

Your default email address is yourdomain@yourdomain.com, and that's where 
all your email will be sent to, unless other configurations take priority (such as 
autoresponders and redirects, mentioned later). 

Back to the top 

 

Microsoft Internet Explorer Email Settings: 
 

The following samples assume that your ISP is Earthlink and your username 
is fred. 
 
Full name = fred  
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Email = fred@earthlink.net 

Internet Mail server = mail.earthlink.net (obtain this information from your 
dialup ISP) 

Account = fred (dialup username) 

Pass = xxxxxx (dialup password) 

Smtp = mail.earthlink.net  

From = anything@fred.com (this can be set to any email account you have 
setup for your domain. 

Back to the top 

 

Netscape Email Settings: 
 

Your Name = fred 

Email Address = fred@earthlink.net (your dialup email address) 

Reply to = anything@fred.com (this can be your email address for your 
domain) 

Mail Server username = fred 

Outgoing Smtp = mail.earthlink.net  

Incoming Smtp= anything@fred.com (this can be any email address you have 
setup for your domain)  

To check numerous POP accounts, read the manual or help files that come 
with your email client software for configuration.  

If you are familiar with the shell (Unix) programs, "pine" and "mail", you can 
use either of these to check and send email as well.  

Back to the top 

 

Microsoft Outlook Email Settings: 
 

1. After loading Outlook, choose Tools... --> Services .. 
 
2. Click add, and choose Internet E-Mail. Click OK. 
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3. In the General tab of the email Properties dialog box, fill in your personal 
information. 
 
4. Click on the Servers tab, and fill in the server information. The Outgoing 
Mail (SMTP) should be your ISP (dialup account) ie: mail.earthlink.net. 
(check with your ISP for this information). The incoming mail server should 
be your domain information;: mail.yourdomain.com. Put in your mailbox 
username in the account name field, and the password below. Click OK. 
 
5. Your new settings will not take effect until you choose Exit and Log off on 
the File menu, and then restart Microsoft Outlook. 
 
Back to the top  
.
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Chapter 4 - CGI-bin 
 

 

CGI-bin General Information 
 

CGI stands for "Common Gateway Interface," a fancy name meaning computer programs 
running on the web server that can be invoked from a www page at the browser. The "bin" 
part alludes to the binary executables that result from compiled or assembled programs. It is a 
bit misleading because cgi's can also be Unix shell scripts or interpreted languages like Perl. 
CGI scripts need to be saved in ASCII format and uploaded to your server's cgi-bin in ASCII 
or text format. This is very important. 

This chapter provides you with information needed when configuring scripts 
and other information regarding your CGI-bin. 

Back to the top 

 

Where to put CGI scripts 
 

Put your cgi-bin scripts in the public_html subdirectory named "cgi-bin".  
 
Back to the top 

 

Paths to Date, Mail, Perl, etc. 
 

Here are your paths to the common server resources that CGI scripts often 
require:  

Date:  /bin/date 
 
Sendmail: /usr/lib/sendmail 
 
Perl5:  #!/usr/bin/perl 
 
Serverpath: /home/username/domain-www/cgi-bin 
 
Root path:  /home/username/ 
    (puts you in your the root of your account) 
  
Domain directory: /home/username/public_html 
    (puts you in your public_html directory) 
  
Cgi-bin path:  /home/username/public_html/cgi-bin/filename 
    (puts you in your cgi-bin) 
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NOTE: Do not include domain extension anywhere you list your domain 
name. 
 
Back to the top 

 

How To Set Permissions 
 

There are three different ways to set permissions for your files and directories within your 
account. 1) File Manager, 2) FTP, and 3) Telnet. We DO NOT encourage the use of Telnet if 
it is only being used for setting permissions and will forego its explanation here. 

Setting Permissions Using Your File Manager 

:Log into your Control Panel and then click on File Manager. You will now 
see a list of directories within the root of your account. Since all of your html 
files and subdirectories are uploaded and created within your public_html 
directory, you need to click on the file folder next to the public-html directory 
name. The directory will open and in the upper right hand corner, there will be 
a list of actions that you can perform for that directory. Next click on the file 
icon located next to the text name of the file that you want to change 
permissions for. Again, in the upper right hand corner you will see a list of 
actions that you can perform with this file. Simply click on Change 
Permissions, select the appropriate permissions and save. 

Setting Permissions using Fetch for MAC: 

If you have Fetch for the Mac, you have an easy way to change permissions. 
Go to the file you want to change the permissions on, and highlight it. Under 
the Remote menu, select Change Permissions. A window will pop up showing 
the current permissions for the file you had highlighted, as shown in the 
screenshot below. Click on the boxes to change permissions as needed. (Refer 
to the Permission Definitions further down this page for an explanation of 
settings.) 
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Setting Permissions Using WS_FTP for Windows: 

WS_FTP accomplishes the same task as above. Just highlight the file you 
want to check, and right-click on it. A menu will pop up, then select CHMOD. 
You will see the window as shown below in the screenshot we've provided. 
Click on the appropriate settings as needed. (Refer to the Permission 
Definitions further down this page for an explanation of settings.) 
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Back to the top 

 

Permission Definitions 
 

Owner = the files users (you) 

Group = the files group 

Others = others Permissions Definitions 

r = read access 
x = execute access 
w = write access 
 
Numerical Definitions: 
 
r = 4 
x = 2 
w = 1 
 
You will come to recognize, if you do not already, Chmod as a word used for 
changing Permissions from within Telnet or your FTP client. 

Some scripts will tell you to chmod 775 (for example). When using the 
numeric system, the code for permissions is as follows: 

4 + 2 + 1 (rwx) = 7 

The first number applies to Owner, the second number applies to Group, and 
the third number applies to Others. Therefore the first 7 of the chmod 775 tells 
Unix to change the Owner's permissions to rxw (because r=4 + w=2 + x=1 
adds up to 7, this giving the Owner Read, Write, and Execute Permission. The 
second 7 applies to the group, this giving the Group Read, Write, and Execute 
Permission, and the last number 5, refers to Others (4 + 1= 5), giving Others 
only Read and Execute Permission. The permissions for chmod 775 look like 
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this: rwx rwx -rx. 
 
Permissions are always broken up into three groups of letters, however if there 
is a dash, this dash simply means that Permission wasn't given for that 
particular function. For example, in the chmod 775, Permission to Write was 
not given to Others. 

Remember: the first 3 letters always apply to Owner, the second 3 apply to 
Group, and the third 3 apply to Others. 

Back to the top 

 

Troubleshooting CGI-bin Problems 
 

Below are solutions to some of the more common CGI script problems. 
 
When I activate my CGI program, I get back a page that says “Internal server 
error. The server encountered an internal error or mis-configuration and was 
unable to complete your request.” 
This is generally caused by a problem within the script. Check your script 
settings again to see that you have entered the correct server information and 
have set the correct permissions for the script. If this information is correct, 
you'll need to contact whoever wrote or is distributing the script for further 
assistance. 
 
I am being told "File Not Found," or "No Such File or Directory." 
Upload your Perl or CGI scripts in ASCII mode, not binary mode. 
 
When I test my Perl script in local mode (by Telnet), I have the following 
error: "Literal @domain now requires a back slash at myscript.pl line 3, 
within string. Execution of myscript.pl aborted due to compilation errors." 
This is caused by a misinterpretation by Perl. You see, the "@" sign has a 
special meaning in Perl. It identifies an array (a table of elements). Since it 
cannot find the array named domain, it generates an error. You should place a 
back slash (\) before the "@" symbol to tell Perl to see it as a regular symbol, 
as in an email address. 
  
I am getting the message "POST not implemented." 
You are probably using the wrong reference for cgiemail. Use the reference /cgi-
bin/cgiemail/mail.txt. Another possibility is that you are pointing to a cgi-bin script that you 
have not put in your cgi-bin directory. In general, this message really means that the web 
server is not recognizing the cgi-bin script you are calling as a program. It thinks it is a regular 
text file. 
Back to the top 
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Chapter 5 - SSL (Secure Server) 
Back To Table Of Contents  
 
Some users have experienced problems using the Secure Server. The most common reason is 
that the user has not inserted the proper code to call the secure server. We have several servers 
and depending upon which server you are on, you will need to enter the server number. If you 
do not know your server number, please complete the technical support request form and we 
will provide you with that information. Following is an example of how the code should look 
when calling the secure server: 

https://server#.webbserv.net/yourdomain/yourpagesecurepage.html 
 
DO NOT INCLUDE the extension for your domain. 

Normally, any text, (such as your credit card number) sent from your browser 
to the web server is sent as plain text. This means that a hacker could 
potentially intercept (however unlikely) the information sent from your 
browser and read it. Therefore, by using the secure server, the information is 
encrypted before it is sent from your browser. It would be practically 
impossible for anyone to decrypt it without knowing the key. 

The following example uses yourdomain as the name of your domain and any 
page as the name of the order form or the page you wish to be secure. 

Use the following URL to call your pages via the secure server. 

https://server#.webbserv.net/yourdomain/anypage.html 
NOTE: Do not use the .com, .net,  etc. extension when putting in your domain 
name.  
 

The above page would be accessed from the normal web server as: 

http://yourdomain.com/anypage.html 
Using formmail.cgi through secure server 
 
If you are calling the formmail through the secure server, your action line and 
other code will look like the following: 

<FORM METHOD=POST ACTION= 
    "https://server#.webbserv.net/yourdomain/cgi-bin/formmail.pl"> 
<input type=hidden name="recipient" 
value="emailaccount@yourdomain.com"> 
<input type=hidden name="subject" value="Order"> 
<input type=hidden name="return_link_URL" value= 
    "https://server#.webbserv.net/yourdomain/yourpage.html"> 
<input type=hidden name="return_link_title" value= 
    "https://server#.webbserv.net/yourdomain/yourpage.html"> 
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NOTE: do not put the .com, .net, etc. extension after yourdomain. 
 
The last two lines allow a link back to your main page - thus they get a report of what they 
ordered and a link. 
It's important that you call your order page through a secure URL (HTTPS) in order for it to 
work properly 
 
Example:https://server#.webbserv.net/yourdomain/yourorderform.html 

NOTE: yourdomain = without the .com, .net, etc. extension. 
 
NOTE: REFER TO CHAPTER 6 FOR INSTRUCTIONS TO INSTALL THE 
FORMMAIL SCRIPT IN YOUR CGI-BIN.  
.
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Chapter 6 - Formmail Codes 
 

Introduction 
 

To use Formmail, you need to create a form on one of your web pages and the formmail.pl 
script should be placed in your cgi-bin. You will need to upload the formmail.pl script from 
Matt's Archives located at  
http://www.worldwidemart.com/scripts/.  
You will need to modify the script for our servers and your domain and the 
formmail.pl script must be uploaded to your cgi-bin in ASCII mode and 
chmod to 777. (the instructions with the script say to chmod to 755, this is 
incorrect and it should actually be chmod to 777). If you need assistance 
applying your script, please submit the Technical Support Request Form and 
we will assist you. 
 
The form action line should be  
<FORM ACTION = "yourdomain/cgi-bin/formmail.pl" METHOD = 
"POST">  
formmail.pl will do all the programming work for you. You alter the behavior 
of formmail by using hidden fields in your form. 
 

There is only one form field that you must have in your form for Formmail to 
work correctly. This is the recipient field.  

 
Field: recipient 

Description: This form field allows you to specify to whom you wish for your 
form results to be mailed to. Most likely you will want to configure this option 
as a hidden form field with a value equal to that of your e-mail address. 

 Syntax:<input type=hidden name="recipient" value="email@yourdomain.com">  

 

Optional Form Fields 
 

Field: subject 

Description: The subject field will allow you to specify the subject that you 
wish to appear in the e-mail that is sent to you after this form has been filled 
out. If you do not have this option turned on, then the script will default to a 
message subject: WWW Form Submission  

Syntax:If you wish to choose what the subject is:  

<input type=hidden name="subject" value="Your Subject"> 
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To allow the user to choose a subject: 

<input type=text name="subject"> 
 

Field: email 

Description: This form field will allow the user to specify their return e-mail 
address. If you want to be able to return e-mail to your user, we strongly 
suggest that you include this form field and allow them to fill it in. This will 
be put into the From: field of the message you receive. NOTE: in your code 
use all-lowercase for the word "email" 

Syntax:<input type=text name="email"> 

 
Field: realname  

Description: The realname form field will allow the user to input their real 
name. This field is useful for identification purposes and will also be put into 
the From: line of your message header. 

 Syntax:<input type=text name="realname"> 

 
Field: sort  

Description: This field allows you to choose the order in which you wish for 
your variables to appear in the e-mail that FormMail generates. You can 
choose to have the field sorted alphabetically or specify a set order in which 
you want the fields to appear in your mail message. By leaving this field out, 
the order will simply default to the order in which the browser sends the 
information to the script (which isn't always the exact same order they 
appeared in the form). When sorting by a set order of fields, you should 
include the phrase "order:" as the first part of your value for the sort field, and 
then follow that with the field names you want to be listed in the e-mail 
message, separated by commas. 

 Syntax:To sort alphabetically:  

<input type=hidden name="sort" value="alphabetic"> 
To sort by a set field order:  

<input type=hidden name="sort" value="order:name1,name2,etc..."> 
 

Field: redirect  
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Description: If you wish to redirect the user to a different URL, rather than 
having them see the default response to the fill-out form, you can use this 
hidden variable to send them to a pre-made HTML page. 

Syntax: To choose the URL the user will end up at: 

<input type=hidden name="redirect" 
    value="http://domain.com/file.html"> 
To allow the user to specify a URL he/she wishes to travel to once the form is 
filled out: 

<input type=text name="redirect"> 
 

Field: required  

Description: You can now require for certain fields in your form to be filled in 
before the user can successfully submit the form. Simply place all field names 
that you want to be mandatory into this field. If the required fields are not 
filled in, the user will be notified of what they need to fill in, and a link back 
to the form they just submitted will be provided. 

Syntax: If you want to require that the user fill in the email and phone fields in 
your form so that you can reach them once you have received the mail, use a 
syntax like: 

<input type=hidden name="required" value="email,phone"> 
 

Field: env_report  

Description: Allows you to have Environment variables included in the e-mail 
message you receive after a user has filled out your form. This is useful if you 
wish to know what browser they were using, what domain they were coming 
from or any other attributes associated with environment variables. The 
following is a short list of valid environment variables that might be useful: 

REMOTE_HOST - Sends the hostname making a request. 
REMOTE_ADDR - Sends the IP address of the remote host making the 
request. 
HTTP_USER_AGENT - The browser the client is using to send the request. 
General format 

software/version 
library/version  
 

Syntax: If you wanted to find the remote host and browser sending the 
request, you would put the following into your form: 
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<input type=hidden name="env_report" 
     value="REMOTE_HOST,HTTP_USER_AGENT"> 

 
Field: title  
Description: This form field allows you to specify the title and header that will 
appear on the resulting page if you do not specify a redirect URL.  
Syntax: If you wanted a title of 'Feedback Form Results': 

<input type=hidden name="title" value="Feedback Form Results"> 
 

Field: return_link_url  

Description: This field allows you to specify a URL that will appear as a 
return_link_title on the following report page. This field will not be used if 
you have the redirect field set, although it is useful if you allow the user to 
receive the report on the following page, but want to offer them a way to get 
back to your main page.  

Syntax: <input type=hidden name="return_link_url" 

     value="http://domain.com/file.html"> 
 

Field: return_link_title  

Description: This is the title that will be used to link the user back to the page 
you specify with return_link_url. The two fields will be shown on the 
resulting form page as: 

<ul> <li><a href="return_link_url">return_link_title</a> </ul> 
Syntax:<input type=hidden name="return_link_title" value="Back to Main Page"> 

 
Field: background  

Description: This form field allows you to specify a background image that 
will appear if you do not have the redirect field set. This image will appear as 
the background to the form results page.  

Syntax:<input type=hidden name="background" 

     value="http://domain.com/image.gif"> 
 

Field: bgcolor  

Description: This form field allows you to specify a bgcolor for the form 
results page in much the way you specify a background image. This field 
should not be set if the redirect field is. 

Syntax: For a background color of White: 
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<input type=hidden name="bgcolor" value="#FFFFFF"> 
 

Field: text_color  

Description: This field works in the same way as bgcolor, except that it will 
change the color of your text.  

Syntax: For a text color of Black:  

<input type=hidden name="text_color" value="#000000"> 
 

Field: link_color  
 
Description: Changes the color of links on the resulting page. Works in the 
same way as text_color. Should not be defined if redirect is.  
 
Syntax: For a link color of Red: 

<input type=hidden name="link_color" value="#000080"> 
 

Field: vlink_color 
 
Description: Changes the color of visited links on the resulting page. It works 
exactly the same as link_color. Should not be set if redirect is.  

Syntax: For a visited link color of Blue: 

<input type=hidden name="vlink_color" value="#0000FF"> 
 

Field: alink_color  
 
Description: Changes the color of active links on the resulting page. Works 
exactly the same as link_color. Should not be set if redirect is. 

 Syntax: For a visited link color of Blue: 

<input type=hidden name="alink_color" value="#0000FF"> 
 

Any other form fields that appear in your script will be mailed back to you 
and displayed on the resulting page if you do not have the redirect field set.  
.
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Chapter 7 - MS FrontPage 
 

.We have provided the following information as a courtesy. Should you need 
further assistance with FrontPage 98, Microsoft's FP Authoring Site. 

The most common asked question users ask when using FrontPage is:  
 
The default page still shows up even after I have uploaded my index page. 
 
SOLUTION: You MUST DELETE the default page before your index page 
will show up 

Click on the version of Front Page that you are using: 
Front Page 98 or Front Page 2000 
 

MICROSOFT FRONTPAGE 98 

Publishing a Web 
Opening an Existing Web 
Troubleshooting problems in FrontPage 98 
Further Microsoft FrontPage Support 

Publishing a Web 

After you have built your html documents and are ready to upload them to our 
server:  
 
1. Open the web you've created on your PC using FP Explorer. 

2. Choose File > Publish 

3. If your "Destination Web Server" doesn't appear in the Publish window (it 
won't the first time you publish to our server) CHOOSE "More Webs" and 
type the location of the web to publish to. Hit return. IMPORTANT: Use 
www.yourdomain.com as the Destination Web Server to publish to our server. 
Leave the "Destination Web Name" BLANK. 

4. You will be asked for your USERNAME and PASSWORD. This is your 
domain's USERNAME and your FrontPage PASSWORD (which may be 
different than your regular telnet/ftp/POP password). If you're not sure what it 
is or if you aren't allowed past this point, you'll need to contact us for a new 
FP password. 

5. You can watch the progression of the upload by looking at the bottom left 
corner of FP Explorer. 
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 Back to the top 

Opening an Existing Web 

1. 1.Open FP Explorer and choose File > Open Front Page Web.  

2. 2.You can now choose to open a previously created web on your PC or your web 
on our server. 

3. 3. Highlight the appropriate web or type in the web address  

4. 4. (www.yourdomain.com) and click OK.  

5. 5. Enter your USERNAME and FP PASSWORD if required.  

6. 6. Make modifications and recalculate links if needed. (See FP help docs for info 
on when it's necessary to recalculate links. 

7. Back to the top 

8. Troubleshooting Common Problems with FP98 

9. Getting error - "Root Web Busy" 

10. FTP or telnet to your site and remove the "service.lck" file in 
/public_html/_vti_pvt. This usually happens when an FP session is interrupted 
before completion.  

11. Server timing out when publishing large sites 

12. .This difficulty arises when the uploading link times out in the process of copying 
the web to our server. The only suggestion Microsoft has offered so far is to break 
the main web into a group of sub webs on your PC, then upload these 
individually. If this problem persists for you, please contact support. 

13.  
Getting Error - "Front Page Extensions not Installed 

14. We often see this error being reported, even when the extensions have been 
installed. If you get this error, please contact support and we'll make sure the 
extensions are installed and repair them if necessary. NOTE: The extensions are 
easily corrupted. Please use only FP Explorer to update your web site on the 
server, not FTP.  

15. I published but my web's not there!  

16. This will happen when the "Destination Web Name" is filled in when publishing 
to our server. 
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17. This box should be left blank. If you put any other name in this box it will create a 
subdirectory off of your root web and copy all of your files into it. Your site will 
exist under a subdirectory instead of at the top level /public_html where it should 
be.  

18. My counter, bbs, guestbook, etc isn't working.  

19. These problems are generally due to incorrect permissions on either the directory, 
file(s) or cgi script(s) that are associated with them. Please don't change the 
permissions of your files or directories unless you have a specific reason for doing 
so and you know what effect it will have on your site.  
 

20. My forms won't work through the Secure Server. 

21.  The call to a cgi script using the Secure Server must not be within a webbot. Use 
a normal cgi call in your html script for Secure Server calls.  
 
My search bot doesn't return any results. 

22. The /public_html directory must be world readable AND you need to  

23. Re-calculate links BEFORE publishing (or after editing directly on the server). If  

24. it still doesn't work: FTP to the server and go to the  

25. /public_html/_vti_txt/default.wti directory. .Delete any files that begin with  

26. "ALL.". Don't delete any other files. Then using Windows Explorer, do the  

27. same thing on your PC.- Recalculate links, test locally with your browser and 
publish.  

28. FP starts the Web Publishing Wizard when I try to publish. 

29.  Cancel the operation and email support to have the FP extensions 
installed/repaired. 
 
Why is my page renamed on the server when I publish?  

30. The "Default Document" of your web is automatically renamed by the server to 
what is required by the configuration of the server. For example, if you've named 
the main page "index.html", it may be renamed "default.html". Just check the 
links to your main page to make sure they refer to it the same way.  

31. Back to the top 

32. Microsoft FrontPage 2000 
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33. This tutorial will guide you step-by-step through configuring Microsoft FrontPage 
to exchange files between your computer and your web site. 
In order to follow along with us, you'll need to have Microsoft FrontPage 
installed, and you'll need to be connected to the internet via your Internet Service 
Provider 

34. Create a Simple Page  

35. Before you can publish an html file to your web site with FrontPage, you must 
either have a page already created, or create a page. To create a page with 
FrontPage, follow these simple steps 

36. :1. With FrontPage open, choose File --> New. 

37.  2. Type in "This is a simple test" 

38.  3. From the menu bar, choose File --> Save As. 

39.  4. Name the html file. 

40.  (If this file is to be your homepage, be sure to name it index.html) 
Once you have the file saved to your hard drive, you are ready to publish the file. 

41.  Publish Your Web Page. 

42.  1. From the menu bar, choose File --> Publish Web .  

43.  

 
 
You'll get a dialog box like this: 
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44.  

 
 
2. Click on the Options button 

45. You will see a dialog box like this 

46. : 

 
3. In box below Specify the location to publish your site to: enter the full URL for 
your site. 

47. 4. If this is the first time you are publishing your site, select Publish all pages...  
 
5. Select Include subwebs. 

48. You should now have a dialog box that looks like this: 
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49.  

 
 
Obviously, you will have put your real domain name instead of 'mydomain.com' 

50.  6. Click the Publish button. 

51.  You should now see a dialog box like this one: 

52.  

 
 
7. Enter your username and password. 

53.  If you have entered all the details correctly, FrontPage 2000 will then publish 
your site. You will see a dialog box like this one when it has finished: 
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8. Click Done. 

Further Microsoft FrontPage Support 
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If you need further assistance using FrontPage, go to 
http://builder.com/Authoring/FrontPage98/ 
and http://support.microsoft.com/directory/ 
 
Back to the top  
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Chapter 8 - CGI Scripts 
 
Random HTML Editor 
 
Guestbook 
 
Counter 
 
Clock 
 
Countdown 
 
Formmail 
 
Entropy Search Engine 
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Back To Table of Contents 
 
COMING SOON 
.
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Chapter 10 - Cold Fusion 
 
Back To Table Of Contents  

COMING SOON 
.
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Chapter 11 - Real Audio / Real Video 
 
Back To Table Of Contents  
 
We DO NOT have Real Audio server software running on our servers. However, you can 
stream Real Media files by following these instructions: 
 
You will need to create a .ram file that calls your real audio/video file. The .ram file is a text 
file with an absolute URL. This URL will need to be: 
http://yourdomain.com/filename.rm 
 
Typically you'll create a RealAudio file subdirectory under domain-www, and put all your 
audio files there. 
 
Then your .ram file, a.k.a., metafile, will contain an address with this format: 
 
http://yourdomain.com/subdirectory/filename.rm 
 
The "subdirectory" is a subdirectory of your domain-www directory. 
 
So for example: http://yourdomain.com/musicfiles/music.rm Notice: 
The above address goes in the .ram/metafile, not in your HTML code. Your HTML code calls 
the .ram/metafile. Then the .ram/metafile is used to call up the .rm/realmedia file. So for 
example, your HTML code would look something like this: 
 
<a href="http://musicforyou.com/ra/music.ram">Click here to listen to music.</a> 
 
For further support and information, please visit http://www.real.com. 
 



  51

Chapter 12 - File Manager 
Back To Table Of Contents  
 
The File Manager Option within your Control Panel can prove to be a very 
powerful feature. It will handle many of the functions that an FTP or Telnet 
client will handle, all from within your browser. Functions such as setting 
permissions, uploading files from your hard drive, creating and editing html 
files, and creating subdirectories. 
 
When you click on the File Manager feature 
inside your Control Panel, you will find that 
the screen is divided into three frames. The left 
frame will show you your directories and files, 
and the upper  

right hand 
frame is your action frame, and the lower right hand frame is your trash 
folder. 
 
Within each directory, you will see links to create a new file, create new 
folder, or upload files. These actions pertain specifically to the directory that 
you are currently in. You will also see a column of numbers to the right of 
each folder and file. The far right column are the current permission settings 
for that specific folder or file and the column to the left of the permissions is 
the actual size of  that file or folder. 
 
To the right is a sample shot of a list of folders and files. When you click on 
the graphic next to the text link for a folder, it will open that folder and 
display the files and folders within that directory. When you click on the 
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actual text link for a folder or file, actions for that directory or file are 
displayed in the upper right hand corner of your screen. 
 
Locate your public_html folder and click on the 
text link for it. You will see the actions for the 
folder appear in the 

upper right hand corner 
of your screen. To the right is a screen shot of the actions that are available 
when you click on the text link for any folder. 
 
Actions are pretty self-explanatory, so we'll forgo explaining what each do. 
 
However, if you will locate a file rather than a 
folder within your directory listing and click on the 
text link of a file, you will see that the action  

 screen will change to 
the specific actions pertaining to actual files and you will notice that the 
actions that you can perform for files are quite different from those of a folder. 
 
By clicking on Show File, a new window will open and show you what the 
file actually looks like in your browser. By clicking on Edit File, you will be 
taken to a window where you can actually edit the html code within the file 
itself and save the changes. You can also change the permissions for the file, 
or copy, move, delete, or rename. 
 
Remember, DO NOT DELETE OR RENAME any files that the system 
creates. Also, remember that any files that you want available on the World 
Wide Web, must be placed within your public_html folder. 
.
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Chapter 13 - Mail Manager 
 

Web Based Email 
 

Retrieve your email from anywhere. These features allow you to retrieve 
your email no matter where you are.  
When you log into your Control Panel and click this feature from within 
your Mail Manager, a screen will pop up asking you to answer some 
simple questions that will configure the program for your use. After 
saving your answers, the mail program will start and you'll be taken to 
the screen that shows your Inbox.  
NOTE: NeoMail will only accept mail sent to your default address, so 
be sure to type in your default address in the Reply-To box when 
configuring the program. If you use a different address, people will not 
be able to reply to your messages.  
At the top of the screen you will find control panel icons as shown in 
the graphic below. Click on icons shown here for an overview of each 
tool.  

 

 
Compose New Message  
 
Choosing this option will open a screen for creating a new email 
message. The default information you entered in the configuration (the 
answers to the questions the program asked when you first started it) 
will appear in the correct boxes, so you only have to fill in two boxes: 
the email address of the person you want to send your message to, 
and the subject line.  
Additional options include:  

? ? CC 
This means Carbon Copy. Add additional addresses here if you want to send a 
copy of the email to more than one person. Separate addresses with a comma, but 
do not add a space between them: 

friend@email.com,friend2@email2.com.friend3@email3.com 

? ? BCC 
This means Blind Carbon Copy. When you use the Carbon Copy option above, all 
the email addresses you entered will appear in the header of each recipient's 
message. You may not want all the addresses to show in the headers, either 
because you don't want the main recipient to know you are sending copies to 
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others, or because you don't want to publish everyone's email address without 
their permission.  

If you don't want the email addresses to show, place them in the BCC box 
instead of the CC box. Add them the same way as before, separated by 
commas but without any spaces between.  

? ? Attachment 
You can attach a file to your email message by clicking on the Browse button and 
choosing the file that you want to send. However, remember that many of the files 
on your computer are quite large in comparison to email messages. If the file is 
too big, the recipient's ISP may reject it, or the recipient may choose not to open it 
due to excessive download time. 

You can add a signature to your message by simply replacing the 
NeoMail message with one of your own. A signature is a short 
message that appears at the end of every email you send.  
Links can be added to your signature by typing the full URL. For 
example: 
Visit my site at http://mysite.com 
 
This will appear in the recipient's email as: 
Visit my site at http://mysite.com 
 
Recipients will be able to visit your site by clicking on the link.  
 
NOTE: Do not use anchor tags. Just type the URL as illustrated above. 
Some older email programs can't translate clickable links. The recipient 
will be able to visit your site by using copy and paste to place the URL 
into their browser.  
 
Back to Control Panel Graphic  
Refresh  
This button refreshes your window and activates any changes you 
have made.  
Back to Control Panel Graphic  
User Preferences  
This option allows you to make changes to the preferences you 
entered when you accessed the program for the first time.  
Simply make any changes you want, then click on the Save button at 
the bottom of the page.  
NOTE: If you decide not to make any changes at this time, click the 
Cancel button at the bottom of the page rather than using your 
browser's back button. This will return you to the NeoMail program. If 
you use your browser's back button instead, you will be taken back to 
Email Manager main screen.  
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Back to Control Panel Graphic  
Address Book  
Click on this button to add entries to your Address Book.  
The address book provides you with a quick way to send mail. Just 
click on the Address Book icon and a list of names with email 
addresses will appear. Click on the email address of the person you 
wish to send a message to, and a new email message window will 
appear with their address already filled in.  
 
Back to Control Panel Graphic  
Folders  
This tool allows you to add folders to your NeoMail program so you can 
more easily organize your messages. For example, you may want to 
add a folder named Work and place all your work-related messages 
there.  
When you click on the button, a box will appear where you can type a 
name for the new folder. Click on Add, then click the Back button on 
your browser a couple of times to get back to the main window. Then 
click the Refresh button, and the new folder name will appear in the 
drop down list of folders at the top of the NeoMail screen.  
 
Back to Control Panel Graphic  
Empty Trash  
This button empties the holding file where messages you have deleted 
are kept. It's a good idea to always empty this file before you close 
NeoMail.  
Back to Control Panel Graphic  
Move to Folder  
 
This tool allows you to move a message to any folder. Just choose the 
folder you prefer from the drop down menu and click the MOVE button.  
To access messages in a given folder, choose the folder name in the 
drop down menu at the top left of the NeoMail screen.  

Back to Control Panel Graphic  

 

Creating / Deleting Pop Email Accounts 
 

To create a new pop email account click on Click Here To Add New 
Account. You will be taken to a new screen:  
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Type the username you want in the Email box, and the password you 
choose for this account in the Password box. Click Create and your 
new account will be activated.  
In order to receive mail sent to this address, you must set up the new 
account in the program you use for email. For example, if you access 
your email through your browser, you need to add this account to your 
browser's email program.  
New accounts are added to email programs in various ways. If you are 
unfamiliar with how your email program works, you will need to access 
the support files for information on your particular program.  
However, most programs will ask you for a username and two 
services. One service will be POP3 and the other is usually SMTP.  
Type in the username that you chose for your new account. Type your 
domain name where it asks for your POP3 account. For example, 
yourdomain.com. Do not add your username in the POP3 box, just 
the domain name as illustrated.  
SMTP is your ISP - the service you use to send email. You cannot 
send email from the server that your domain is installed on. You can 
only receive mail through your domain server. Most programs just want 
you to type the domain name of your ISP, which is the last part of your 
email address: yourISP.com, where your email address is 
yourname@yourISP.com.  
These are typical instructions for setting up a new email account. Your 
program may require something different. It is not possible for us to 
provide instructions for every possible configuration, nor provide 
support for your individual software. If you have problems, please 
contact your software provider for support.  
To delete a pop account, click on Click Here To Delete Account, 
choose the address you want to delete from the drop down menu, and 
click the Delete button.  

 

Default Email Account 
 

Click this link to set the default email account. Your default email account is your "Catch All" 
email account. Any mail addressed to your domain that does not have an individual account 
set up for it will automatically go to this address.  
You can change the username portion of your default address. Just 
click on Click Here to Change Default Address and type in the new 
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address. Type the entire address: yourname@yourdomain.com. 
Then click Change.  
Make sure you are using an account that actually exists. If the account 
doesn't exist, set it up using the Pop Email Accounts feature.  

 

Setup Autoresponders 
 

Auto-responders will automatically send an email for you. Autoresponsers are 
typically used to send information in response to a visitor's request.  
For example, visitors can click on a link that says Click Here to 
Receive Special Report. When the visitor clicks on the link, their 
email program will open a new message addressed to your 
autoresponder. When they send the email, your autoresponder will 
reply by automatically sending your Special Report to the visitor.  
To create an Autoresponder, just click on Click Here To Add 
AutoResponder.  

 
In the Email box, type the username you choose for your 
Autoresponder. This will be the email address that visitor's click on to 
access the Autoresponder. If you think you may set up more than one 
Autoresponder, it is helpful to choose a username that is descriptive. 
For example, reportx. The mailto link you will place on your site will be 
reportx@yourdomain.com.  
Fill in the From and Subject boxes, then place the information you want 
to send in the Body area. You can't use html tags in an Autoresponder. 
They will only accept plain text.  
When you are finished, just click the Create button, and your 
Autoresponder is ready to go.  
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Block Unwanted Email 
 

You can block unwanted email according to email address, subject, any header, recipient, or 
even phrases inside the body of the message.  
Just use the drop down menus to choose what you want blocked. For 
example, you might want to filter out porn sites. You could choose 
Subject, Body or Any Header from the first drop down menu, and 
Contains from the second drop down menu. Then type a phrase or 
word that frequently appears in the header or body of email you 
receive that promotes porn sites.  

 
To block email from a specific source, just choose From in the first 
drop down menu, then Equals from the second menu. Type in the 
person's email address in the box and click Activate.  

 

Email Forwarding 
 

You can have any or all email addressed to your domain account forwarded to 
an outside email account or to a different email address within your domain.  
Simply type the username of the address you want mail forwarded 
from in the first window, and the complete email address you want the 
mail forwarded to in the second window.  

 
Remember, you can forward mail to any address, inside or outside of 
your domain. For example: yourmail@aol.com or 
yourmail@yourdomain.com.  
To stop forwarding mail, simply choose the address you want to stop 
from being forwarded, and click on delete.  

 

About Email Aliases 
 

You never have to create email aliases. Your default email account is setup as a "Catch All" 
account, meaning that any email coming to anything@yourdomain.com is delivered to your 
default account. 
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Create Email Lists 
 

INSTRUCTIONS NOT COMPLETED YET.  
.
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Chapter 14 - Changing Passwords 
 

Changing Passwords for Control Panel & FTP 
 

Go to your Control Panel at http://www.yourdomain.com/cpanel/ and click on Change 
Password and follow the instructions. 

If you are unable to access your Control Panel because you've lost your password, you will 
need to submit a Technical Support Request form and provide us with a new password. 
Passwords are one way encrypted, therefore, we can't even pull up your password. 

 

Changing Passwords for Email Accounts 
 

Currently there is no way to change the password for your email accounts 
unless you delete the account and then re-create it. 
.
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Chapter 15 - Site Statistics 
Back To Table Of Contents 
 
This feature inside your Control Panel provides you with valuable information regarding visitors to your site. 
We've also included the Error log here, simply because we didn't know where else to put it 
 
Analog 
Analog produces a simple summary of all the people who have visited your site. It is fast and provides great light
weight statistics 
 
Webalizer 
Webalizer is a more complex stats program, which produces a nice variety of charts and graphs about who has 
visited your site. This is probably the most popular stats engine available today. You can also view this 
information in the logs from your Ftp Site (if you have one). 
 
Last Visitors 
This will show you the last 300 visitors who came to your site, and some interesting information about them.  
 
Error Log 
This will show errors in your site, images not loading, missing files, etc. This is very useful for debugging a cgi 
script.  
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Chapter 16 - Network Tools 
Back To Table Of Contents  
 
This feature inside your control panel is pretty self -explanatory... 
.
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Chapter 17 - FTP 
IN THIS SECTION 
 
Multiple FTP Accounts | Anonymous FTP 
Back To Table Of Contents  
 
Multiple FTP Accounts: 
 
Users whose account plans include Multiple FTP accounts can setup ftp 
access for users through the FTP Feature inside your Control Panel. From 
inside the FTP feature, click on FTP Accounts and add a username and 
password for the user that you are granting ftp access. The user then can 
access your account utilizing the same instructions you received with your 
welcome letter. 
 
Anonymous FTP: 
 
Virtual domain account users whose plans include Anonymous FTP can allow 
anonymous FTP access to visitors wishing to download or upload files to your 
web site as if you were running your own FTP server. 
 
You can enable (and disable) ANON FTP access within the FTP Feature 
inside your Control Panel. 
 
ANONYMOUS FTP WARNINGS: 
 
Security 
 
Anonymous FTP will grant any and all users the ability to access your 
"upload" directory, or any directory on your domain that has been set for 
"public" read/write permissions. Anonymous users will have access to upload 
or download files to and from your domain. You must set the appropriate 
permissions for your directories to restrict anonymous FTP access. This is 
needed to ensure that anonymous users will not be able to access any existing 
files or directories. You can inhibit access to specific files and directories 
using the File Manager by disabling public read and/or write access to the 
files or folders you don't want people to see (i.e.. cgi-local). 
 
Responsibility 
 
As the account owner, you are responsible for any and all files that are stored 
on your domain. This would include files that were uploaded by you as well 
as by anonymous FTP users. With the use of anonymous FTP, your site is 
susceptible of becoming a "warez" site. Typically, these are sites that are used 
by "hackers" to trade (upload/download) illegally pirated copies of software 
programs with one another. As the account owner, the complete content of 
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your account is your responsibility. If your site becomes a trading post for 
"warez" programs, you may face legal action that can be taken against you by 
the programmers/software companies of the copyrighted software, in addition 
to your account being deleted from our servers. Please refer to our User 
Agreement for more information. 
 
Data Transfer 
 
Any and all FTP download transfers, anonymous FTP included, will be used 
in the calculation of the total data transfer for your account. If this total data 
transfer amount exceeds the limit that is set for your plan, you will be 
responsibility for any and all overage charges that occur. Please Note: There 
will be NO exceptions made for these overage charges. Once anonymous FTP 
has been enabled, it will be your responsibility to monitor the anonymous FTP 
activity for your account. All anonymous FTP activity is stored within the 
"xferlog" file. This file contains entries for each and every anonymous FTP 
upload/download session. This file is located within the /stats directory of 
your account. There is also a link provided off the "View your web usage 
statistics & logs" page of your account control panel. 
 
Disk Space 
 
If you are going to allow people to upload files to your site, make sure you 
keep track of your disk space usage via your Control Panel. Do not allow your 
disk space usage to get too close to your maximum disk space allocation or 
you may experience problems accessing your site via FrontPage and/or be 
unable to upload or modify files. 
 
Once you enable ANON FTP in your Control Panel, files can be accessed 
anonymously via FTP client. 
 
Anonymous visitors wishing to access your site via FTP client (e.g. wsftp) 
must use your domain name as the FTP hostname, userid of anonymous and 
password of guest. 
 
Your anonymous ftp site is completely different from your web site. 
 
When people ftp to your domain anonymously, they will see the following 
directories: 
 
bin/ 
dev/ 
etc/ 
incoming/ 
lib/ 
pub/ 
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"pub" is where you should put all your anonymously accessible files. 
"incoming" is for the anonymous users to upload files. 
  
For security the following applies: 
 
-Only the incoming directory can be written to anonymously 
 
- Sub-directories are not creatable  
- The incoming directory is not readable by people dropping files there  
 
You are responsible for any "pirated" software uploaded by the anonymous 
users. The anonymous ftp sites will be periodically monitored for any abuses.  
 
You may ignore the other directories. 
 
To access the anonymous FTP site via the web, use the following address: 
ftp://yourdomain.com/pub/ 
 
Your HTML to download a file called something.exe from a web page would 
look like this:  
 
<A HREF="ftp://yourdomain.com/pub/something.exe">Download Something 
Now</A> 
 
You should tell your visitors that they may need to right-click on the link if 
they are PC users, or if they use a Macintosh, they need to hold down the 
mouse button on the link, then select the appropriate option from the Pop-up 
menu. 
.
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Back To Table Of Contents 
 
This feature is being developed and therefore not yet working from within 
your Control Panel. However, once it is completed, users will be able to log 
into this feature and issue shell and telnet commands in the same manner as 
they do from telnet software.  
.
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Chapter 19 - Password Protect Directory 
Back To Table Of Contents 
 
The Password Protect Directory feature in your Control Panel allows you to 
restrict access to a particular directory within your account and allowing 
access by assigning usernames and passwords to individuals that you choose 
to allow such access. 
 
When you click on this option you will be asked to select the directory that 
you want to protect. Simply click the text link of the directory name and you 
will be taken to the screen where you complete the specifics for user 
information. 
 
To add a new user, simply input the username and password and click “Save.” 
You will be carried to a screen that will confirm the new user and you can 
click the link in the left menu to go back and add more users. 
 
To change a password for a user, simply input the username and the new 
password for the user and click “Save.” You will be carried to a screen that 
will confirm the new user and you can click the link in the left menu to go 
back and add more users. 
 
NOTE: Usernames and passwords MUST be from 6 to 8 characters long. Any 
less than 6 or greater than 8 will cause your protected directory to cease to 
function and you will receive an error when trying to enter the directory. 
 
To delete a user, select the user from the list and click the Delete button at the 
bottom of the screen 
 
AFTER SUBITTING ANY ACTIONS, BE SURE TO HIT YOUR 
RELOAD/REFRESH BUTTON IN YOUR BROWSER TO SEE THE 
CURRENT CHANGES.  
.
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Chapter 20 - Custom Error Pages 
Back To Table Of Contents  
 
This feature allows you to customize the various error pages for your domain. 
 
Not much to explain or instructions to give here...pretty self- explanatory. 
 
Simply click on the feature and whichever error page  you want to customize 
and enter your html code and save.  
.
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Chapter 21 - MySQL 
Back To Table Of Contents  
 
The MySQL option in your control panel automates MySQL. 

The information contained in the following pages was provided to us by one 
of our users, Mr. Hamp Turner of The Flick Haus. This information will assist 
you in utilizing the MySQL feature that is located inside your Control Panel. 

We do not provide technical support for using MySQL, however you will find 
loads of useful information as well as additional resources that will assist you 
along your way. 

Overview | MySQL Control Panel Feature | Examples of SQL Statements | 
Quick Actions 
Advanced Queries | Table Properties | Table Select | Perl SQL Delete Example 
Perl SQL Insert Example | Perl SQL Update Example | Perl While Loop 
Example 
View Dump Database Schema | Using MySQL With CGI Scripts 
References and Tutorials 
.
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Chapter 22 - Mime Types 
 

Explanation of Mime Types 
 

This feature is not available for FrontPage users. Is any Mime types are needed, FP users will 
have to be added using FrontPage. 

The MIME Types option in your Control Panel allows you to set certain programs to be used 
for specific extensions. 

In easier-to-understand terms, MIME Types help your web server to identify what type of file 
is being requested by your browsers. For instance, when the web server gets a request from a 
browser such as Internet Explorer or Netscape, for a file that ends in .html, the web server 
knows that it is an html document because that extension is stored in the Mime Type. If the 
web server gets a request from a browser for a file that ends in .gif, the web server knows that 
it is an image because that too is stored in the Mime Types. This applies to every file, image, 
application, etc. that may be requested by a web browser. If the extension is not stored within 
the Mime Type, the web server will not recognize it and will not be able to assist the browser 
and that particular file type will not be viewable by the user. 

Mime types are identified by the server by the following format: 

subtype/type extension 
For example, adding the following two Mime Types will allow users to view 
ipx images on your web pages: 

application/x-ipscript    .ips 
application/x-ipix    .ipx 
application identifies the subtype, x-ipscript identifies the application, and .ips 
identifies the extension used for that application. 
 
For more information on Mime Types you can visit 
http://www.qnx.com/~chrish/Be/info/mime-types.html 
.
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Chapter 23 - Crontab 
Back To Table Of Contents  
 
We want to make it very clear up front for you NOT TO ABUSE this feature. In the event that 
we determine that you are abusing the system from your use of this feature, it will be disabled 
and we will not argue the point with any client. If you know how to use Crontab, then you are 
quite aware of the drain that this feature can cause on a server. Precautions that you should 
take are: 
 
Limit the number of processes that you run. 
 
Do not run processes every min. 
 
Schedule your processes to run between midnight and 6:00am CST. 
.
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Chapter 24 - Entropy Chat 
Back To Table Of Contents 
 
This feature enables you to install a chat room on your site. Simply click on the feature and 
obtain the code that you will need to paste into your pages where you want the chat to appear. 
.
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Chapter 25 - Shopping Cart 
Back To Table Of Contents  
COMING SOON 

.
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Chapter 26 - Search Engine Submissions 
 
Back To Table Of Contents  
 
This option in your Control Panel will allow you to submit your url to various search engines 
at the click of your mouse. 
 
We are experimenting with several different scripts at this time, so please be patient with us in 
the event that it is different each time that you go in to use this feature...they all still do the 
same function.  
.
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Chapter 27 - PGP & PGP Mail 
 

 

What is PGP? 
 

PGP = Pretty Good PrivacyTM 
PGP allows people to exchange email with both privacy and authentication. 

 

How To Create The PGP Mail Key 
 

Before using PGPMail, you will need to create a public key using your email software. Your 
email software should have instructions to create the key. Once the key is created, you enter 
the PGP option inside your control panel and paste the PGP Key text into the box provided 
and then click add. 

The key code should look similar to the following 

:-----BegiN PGP PUBLIC KEY BLOCK----- 

Version: PGPfreeware 5.0i for non-commercial use 
mQGiBDZiwWERBADgftCC3ZrT1JHcK5gvSA7Tuw5CmU2c8NWrFzAyw
kARHh7niTFJ 
sg1VfEi5ExsNDBVvmvr+vZD6Zq9eYtodkx1E41gJFZegGHzqya+WaiGknQ
6zUVEm 
gw9NGpIA2+iyR3FrGPG8Fq3MvF+8qNm9LGUVR6jjBwdERpRDkmnShg/
QSQCg/87M 
................................................................ 
tbzYRdmHzvGpR/Hvo7NKKhF0Z3Xu+5KeXsI8iQA+AwUYNmLBgGAlch
3jE84DEQLI 
IgCg5wk8RciT6SL5/hdg5QMb6h/n8e0Ali0k3+TFSGtLwdn+YOn6hkYnfSU
= 
=jZZO 
-----END PGP PUBLIC KEY BLOCK----- 

 

Using PGP Mail 
 

To use PGPMail, you need to create a form on one of your web pages. 
 
The form action line should be: 
 
<FORM ACTION = "/cgi-bin/pgpmail.pl" METHOD = "POST"> 
 
pgpmail.pl will do all the programming work for you. You alter the behavior 
of pgpmail by using hidden fields in your form. 
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Necessary PGP Form Fields 
 

There are three form fields that you must have in your form for PGPMail to 
work correctly. This is the recipient, username, and keyname fields.  

Field: recipient  

Description: This form field allows you to specify to whom you wish for your 
form results to be mailed. Most likely you will want to configure this option 
as a hidden form field with a value equal to that of your e-mail address. 

Syntax: <input type=hidden name="recipient"  

value="your_username@localnet.com"> 
Field: username  

Description: This form field allows you to specify your username in the 
system. This allows PGPMail to look for the configuration files to encrypt the 
mail to be sent to you. You should replace "yourusername" with your main 
username on the system. 

Syntax: <input type=hidden name="username" value="yourusername"> 

Field: keyname 

Description: This form field allows you to specify the name of your public 
key. This will be the public key that PGPMail uses to encrypt your mail. You 
must possess the private key in order to decrypt the email that is sent. You can 
get your public key name by going to the PGP Manager. It is typically just 
your email address. 

Syntax: <input type=hidden name="keyname" value="publickeyname"> 

 

Optional PGP Form Fields 
 

Field: subject  

Description: The subject field will allow you to specify the subject that you 
wish to appear in the e-mail that is sent to you after this form has been filled 
out. If you do not have this option turned on, then the script will default to a 
message subject: WWW Form Submission  

Syntax:If you wish to choose what the subject is: 

 <input type=hidden name="subject" value="Your Subject"> 
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To allow the user to choose a subject: 

<input type=text name="subject"> 

Field: email  

Description: This form field will allow the user to specify their return e-mail 
address. If you want to be able to return e-mail to your user, I strongly suggest 
that you include this form field and allow them to fill it in. This will be put 
into the From: field of the message you receive.  

Syntax: <input type=text name="email">  

Field: realname  

Description: The realname form field will allow the user to input their real 
name. This field is useful for identification purposes and will also be put into 
the From: line of your message header.  

Syntax: <input type=text name="realname">  

Field: sort  

Description: This field allows you to choose the order in which you wish for 
your variables to appear in the e-mail that PGPMail generates. You can 
choose to have the field sorted alphabetically or specify a set order in which 
you want the fields to appear in your mail message. By leaving this field out, 
the order will simply default to the order in which the browser sends the 
information to the script (which isn't always the exact same order they 
appeared in the form.) When sorting by a set order of fields, you should 
include the phrase "order:" as the first part of your value for the sort field, and 
then follow that with the field names you want to be listed in the e-mail 
message, separated by commas.  

Syntax: To sort alphabetically: 

<input type=hidden name="sort" value="alphabetic"> 

 To sort by a set field order: 

<input type=hidden name="sort" value="order:name1,name2,etc.">  

Field: redirect  

Description: If you wish to redirect the user to a different URL, rather than 
having them see the default response to the fill-out form, you can use this 
hidden variable to send them to a pre-made HTML page.  

Syntax: To choose the URL the user will end up at: 
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<input type=hidden name="redirect" value="http://your.address/to/file.html">  

To allow the user to specify a URL he wishes to travel to once the form is 
filled out: 
<input type=text name="redirect">  

Field: required  

Description: You can now require for certain fields in your form to be filled in 
before the user can successfully submit the form. Simply place all field names 
that you want to be mandatory into this field. If the required fields are not 
filled in, the user will be notified of what they need to fill in, and a link back 
to the form they just submitted will be provided.  

Syntax: If you want to require that the user fill in the email and phone fields in 
your form, so that you can reach them once you have received the mail, use a 
syntax like: 

<input type=hidden name="required" value="email,phone">  

Field: env_report  

Description: Allows you to have Environment variables included in the e-mail 
message you receive after a user has filled out your form. It is useful if you 
wish to know what browser they were using, what domain they were coming 
from or any other attribute is associated with environment variables. 

The following is a short list of valid environment variables that might be 
useful:  
 
REMOTE_HOST - Sends the hostname making a request. 

REMOTE_ADDR - Sends the IP address of the remote host making the 
request. 

HTTP_USER_AGENT - The browser the client is using to send the request. 
General format: 

software/version 
library/version  
 
Syntax: If you wanted to find the remote host and browser sending the 
request, you would put the following into your form: 

<input type=hidden name="env_report" 
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value="REMOTE_HOST,HTTP_USER_AGENT">  
 
Field: title  

Description: This form field allows you to specify the title and header that will 
appear on the resulting page if you do not specify a redirect URL.  
 
Syntax:If you wanted a title of 'Feedback Form Results': 

<input type=hidden name="title" value="Feedback Form Results"> 

 Field: return_link_url  

Description: This field allows you to specify a URL that will appear as 
return_link_title, on the following report page. This field will not be used if 
you have the redirect field set, but it is useful if you allow the user to receive 
the report on the following page, but want to offer them a way to get back to 
your main page.  

Syntax:  
<input type=hidden name="return_link_url"  

value="http://your.host.xxx/main.html">  
 
Field: return_link_title  

Description: This is the title that will be used to link the user back to the page 
you specify with return_link_url. The two fields will be shown on the 
resulting form page as: 

<ul> <li><a href="return_link_url">return_link_title</a> </ul> 

Syntax: <input type=hidden name="return_link_title" value="Back to Main 
Page">  
 
Field: background  

Description: This form field allows you to specify a background image that 
will appear if you do not have the redirect field set. This image will appear as 
the background to the form results page.  

Syntax:<input type=hidden name="background"  

value="http://yourdomain.com/image.gif">  
 
Field: bgcolor  
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Description: This form field allows you to specify a bgcolor for the form 
results page in much the way you specify a background image. This field 
should not be set if the redirect field is.  

Syntax: For a background color of White: 

<input type=hidden name="bgcolor" value="#FFFFFF">  

Field: text_color  

Description: This field works in the same way as bgcolor, except that it will 
change the color of your text.  

Syntax:For a text color of Black 

:<input type=hidden name="text_color" value="#000000">  

Field: link_color  

Description: Changes the color of links on the resulting page. Works in the 
same way as text_color. Should not be defined if redirect is.  

Syntax:  
 
For a link color of Red: 

<input type=hidden name="link_color" value="#000080">  

Field: vlink_color 

Description: Changes the color of visited links on the resulting page. Works 
exactly the same as link_color. Should not be set if redirect is.  

Syntax:For a visited link color of Blue: 

<input type=hidden name="vlink_color" value="#0000FF">  

Field: alink_color  

Description: Changes the color of active links on the resulting page. Works 
exactly the same as link_color. Should not be set if redirect is.  

Syntax: For a visited link color of Blue: 

<input type=hidden name="alink_color" value="#0000FF">  

Any other form fields that appear in your script will be mailed back to you 
and displayed on the resulting page if you do not have the redirect field set. 
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Where To Find Additional Support For Using PGP Mail 
 

Visit the PGP (Pretty GoodTM Privacy) web site for information not 
provided here. 
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Chapter 28 - Subdomains 
 
Back To Table Of Contents  
 
For accounts that have this feature, users can log into this area and setup 
subdomains under their account plan. All subdomains setup through the 
control panel draw their resources from the parent account plan.  
.
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Chapter 29 - Archive Manager 
Back To Table Of Contents  
 
This option in your control panel allows you to compress your directories and/or files located 
in your account. This is an excellent way to backup your own files. It will serve as double 
protection should anything ever go wrong with our backups. 
 
As stated in our policies, we cannot guarantee the quality of our backups as these are geared 
more toward restoring an entire server. We HIGHLY recommend that you make it common 
practice to backup your own web pages. In the event that we are unable to recover your pages 
you will be able to restore your own pages. 
 
Once you've compressed your files, you can FTP the saved file to your hard 
drive for safe -keeping or leave it in your account, the choice is yours to make. 
 
If you ever need to restore the compressed file, just return to this part of your 
Control Panel and select the file that is compressed and click Extract. 
.
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